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Data Acquisition

The dataset used in this tutorial:

® NZ Facilities: Koordinates https://koordinates.com/from/data.linz.govt.nz/laver/105588-nz-facilities/

® Bus Stops: Auckland Transport Open GIS Data https://data-atgis.opendata.arcgis.com/datasets/ATgis::bus-stop/explore

Dataset folder is available in Scratch on lab computers

» ThisPC » Scratch (Z:) » DRH Tutorial Files > Sem 2 TUT ArcGIS @ Layers

S

Mame Date modified Type
s Bus Stops File folder
cratch BusService File folder
Note: Copy the whole data folder (named: Layers) from Scratch Cycle Facility Network File folder
lds-nz-facilities-SHP 28/07/2023 11:07 am File folder

into your ArcGIS project folder.

DRH Tutorial - Data Acquisition Finding Spatial (Map) Info:
https://www.drh.nz/2022/12/09/data-acquisition-finding-spatial-map-info,
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https://koordinates.com/from/data.linz.govt.nz/layer/105588-nz-facilities/
https://data-atgis.opendata.arcgis.com/datasets/ATgis::bus-stop/explore
https://www.drh.nz/2022/12/09/data-acquisition-finding-spatial-map-info/

DRH Intermediate Tutorial - ArcGIS Pro

Launch ArcGIS Pro & Create a New Project

*  Create a new project and give it an appropriate name.

* It should automatically save into Documents > ArcGIS > Projects > (project name)

New Project
|j h L This PC = IDocuments » ArcGIS » Projects » Tuterial I
t - A= Mame Date medified Type Size
Map Catalog Global Scene Local Scene Start without a template
ImportLog File folder
Index File folder
Tutorial.gdb File folder
=1 Tutorial ArcGlS Project File TKE
|| Tutorial.athx ATBX File 1KB
Create a New Project X
| RamCy | Tutoria | This folder will be your main folder to move downloaded content

Location | Ch\Users' Documents\ArcGIS\Projects into.

| Create a new folder for this project
. If you wish to save the project, make sure to copy the entire folder
onto your OneDrive/USB when you are finished.
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ArcGIS ProUser Interface
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®  Begin by going to Koordinates or using the link
provided earlier, find NZ Facilities layer

® Use the zoom tool or search to find the location
of your site

®  Select Crop on the top right. And crop to an
extent you are happy with showing on your
map.

Select Shapefile and click create export (make sure you
are logged into your Koordinates account otherwise you
won’t be able to export)

Coorginare Reference System

NZGO200O / New Zealand Transvarse Marcator 2000 (EPSG2193)
Vector

g 1z Facies
a I' Land Information New Zealand

Once the zip file is downloaded, extract the files and
put it into your ArcGIS Pro Project file
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GeoJSON

®  Similarly for the Auckland Transport data or using the link provided earlier, find bus stops layer.
® Select Draw an area on the right side. And crop to an extent you are happy with showing on your map.
®  Make sure toggle filters is on, then find Download on the left side panel, and choose the Shapefile option

®  Once the zip file is downloaded, extract the files and put it into your ArcGIS Pro Project file
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Adding Datasets

~_ Catalog ViR X
Mechanics Bay Project Portal Favorites =
27.m Search Project L v
1 @ Maps
The University @ Toolboxes
i of Auckland = 5! Databases
* Open catalog pane from View > o
1d . ol 4 5 Folders
Catalog Pane \. z = 4 5, Tutora
i N 2 &3 Tutorial.gdb
* Drag your datasets from your 7 ; < 4 BusStops
8 "/,L LY B *] BusStop.shp
folders, make sure to expand folders B A , 4 Bussenvice

&) BusServiceshp

=) Cycle_Facility_Network.shp

untiI you see ‘Shp’ § : . ; 4 Cycle_Facility_Network

* Drop them into the map and it DA/ 1 . L
X S B nz-facilities.shp
should show up in your contents on i : i B i
. nz-facilities.xml
your left under Drawing Order ¥ Tutorialatb
#" Locators
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Key types of tools in ArcGIS Pro under Map Ribbon

Map Insert

e Locate: searching addresses and auto .., %
zooms into site on the map

* Select:you can choose features on the &
map (select multiple by click + shift) —

* Clear: clears your selection

* Double clicking the layer name under —
content: to rename layers s

* Double clicking the icon in the layer :

opens: Symbologytab

* Gallery — Search a Symbol

* Properties - to edit the colours, line
weights, and styles etc.

* Make sure to click ‘Apply to see the

changes.

Analysis  View  Edit  Imagery  Share labeling  Data
+ Add Graph Attributes =
Ax D
LT 0 ap Add clect 8 M Locat
o XY Data ation
y X
/
¥ 4 %
|
Freamac 6 {
|
| il
\{ )
{
{ /
|

11

€den Terrate bt A\ PR
< \ 5 \ ] e e
A \\\ /
£ \ f
y Ny
? R
( N
4 &\

-

Not signed in (2

Download
Map
~
r <=
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o
Y - - *
- * i3 ¥
t
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Making layers for schools in Grafton

* Using Map > Select, choosethe = - —_ - — ,\Em.mmm

Rename Layer
4 [w| University of Auckland

two UoA buildings and right
click the nz-facilities layer find
selection > make layer from

selected features.
These four buildings are

ACG Parnell

* This will create a layer

lm ; ) —1
! &
0

/ ‘-\A@(,

\ @/ —%7\@\ /"'9

Your map should now look something like below:

individually for UoA and you

can rename the layer to

University of Auckland

* Double click the icon to open

symbology and customise to

your likings.
* Do the same for ACG Parnell

* Hide the nz-facilities layer in

the end
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Creating new features

Create Feature Class v R x Create Feature Class v R
Spatial Reference
cessss

* Under Catalog > Folders > [project 4 5 Folders

¥ Define

. * o e 00
4 g Tutorial

H 1 Select the Coordinate System to view the available
name] and right click the .gdb > New

Name [ Healthcare | Sptione

Current XY Details

NZGD 2000 New

> Feature class 4 W Bus Stops I= | | |

‘‘‘‘‘‘‘ Zealand Transverse
. Feature Class Type Mereator
H I h R , I d Catalog v X
° . h =
Name: Healthcare (|t won't let you do / (e = Cori] Rt = Type of features stored in the feature class. XY Coordinate Systems Available
[ search Project R Toamt ] - ‘

spaces in the name, but you can

Maps

orites

o
& Toolboxes

Databases Geometric Properties

;
. o () NZGD 2000 New Zealand Tr Mercat I
always change it later under \ B Syl — M Values - Coordinates include M values used to | —

4 i Folders O ACG Parnel

e — store route data.
9 4 g, Tutorial - - University of Auckland
Contents) 2 2 Values- Coordinates ince 7 values used to :
lEu Feature Dataset | | New > i—l ' store 3D data. nz-facilities

BusStop
Feature Class + Add To Project

* Feature Class: Point Jyes Pl et

Add To Favorites BusService
O View

[
# Add To New Projects /] Add output dataset to current map () WGS 1984 Web Mercator (auiliary sphere)
S Relationship Class

e Uncheck Z values Import > sgraphic Coordinate System

BB Raster Dataset
Export >

T Mosaic Dataset

* Make sure spatial reference is B T

7 Domains
selecting NZGD 2000 { e

B Copy Ctri+C

Page 1/6 Page 3/6

[Fresous | [ ot ||| e ] [Jconest

Manage

* Hit Finish (if it doesn’t let you, just go =

[l CopyPath Ctrl+Alt+P

to page 1 and save the project file

then hit finish)
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Creating new features
,.

=
* Goto edit > create >
healthcare e |:|
* Select on the map, the three | l__:_|
healthcare options then exit
the edit panel \
* Rename the layer if you wish \\ ‘ \v;

* Double click on the icon to \\\_\ 4 :
customise your symbology \i\\ .7
* Use Gallery and search \\\‘\\\
health \/(\
N

Create Features

Contents
T |Search

t= & [d
Drawing Order

4 [E] Map

4 |y| Healthcare

THE UNIVE

v R X

+ &

Symbology - Healthcare -
® Format Point Symbol

Gallery Properties

=

n x

health

x| [Anstytes -

Symbols found: 12

v ArCGlS 2D

@ T

° G

Hospital | Hespital

Hospital
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Creating a center point on site

* Follow the same steps for creating a new
feature class

* Name: centerpoint

* Feature class: point

* Uncheck z values

* Spatial reference: NZGD 2000

* Finish (remember to save the project file
if it doesn’t let you click finish)

* Edit > Create > Centerpoint

* Select on the map, near middle of

Auckland Domain then exit

Create Feature Class v R X Create Feature Class ¥ ew Jedit | imagery  share Feature Layer  Labeling  Data
i Spatial Ref:
} Define EE la N E-E':”‘:‘ ay = | B 4 x I—E = Attributes » A
e e e 00 + S & Kk <2 s
s #
Snapping | Create flodify Delete | Select = - Move  Annotat
The Finish button is currently disabled due to Select the Coordinate System to view the available =ctor & ~  @@ZoomTo
unsaved edits in one or more maps in the options. & Snapping Features [E] Selection &
O project. X Current XY Details o -
Save or discard thase adit - \ 3
NZGD 2000 New / Paigell
Mame ‘ centerpoint ‘ Zealand Transverse 7
Mercator
Alias ‘ ‘
XY Coordinate Systems Available
Feature Class Type
Search o v | T v &~ \,
Type of features stored in the feature class. B!
worites \
Point " {
rers !
@ NZGD 2000 Mew Zealand Transverse Mercator il
Geometric Properties ACG Parnell
M M Values - Coordinates include M values used to University of Auckland
' store route data. \ /
nz-facilities \ 5 /

0 Z Values - Coordinates include Z values used to
—  store 3D data.

[v] Add output dataset to current map

Page 1/6

BusStop ‘\\ ' N
\ 7

Cycle_Facility_Network

BusService '
@ WGS 1984 Web Mercator (auxiliary sphere) | 7k
¥ sp! ]

ographic Coordinate System

Page 3/6

| MNext | Finish || Cancel |

)
| Previous || MNext I|| Finish |||Cancel |
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DRH Intermediate Tutorial - ArcGIS Pro

1.

2.

Analysis Tools:

To make a buffer: Analysis > Tools

a.

b.

Search up buffer
i. Input: centerpoint
ii. Distance: 500 meters
iii. Run

Edit symbology

Map  Insert
ModelBuilder
PYhon ey To
Use Tools

Envirenments

Geoprocessing

View  Edit  Imagery  Share

H o

Summarize Spatial Pairwise
‘Within Join Clip

Tools

Pairwise
Buffer

[F] Tools

Feature Layer

Qptimized Hot

Spot Analysis

Geoprocessing

[ butted

Buffer (» S
Creates buffer polygons around input features to a specified
distance.

-\ B8

Extension - Requires Login: To make a walkable
catchment: Analysis > Tools

a.

b.

Search up Summarize Nearby

features: centerpoint

i. Requires login and uses credits
ii. Input feature and input summary

Geoprocessing ~ 1

Buffer 3D 30 An ol
Creates a 3-dimensional buffer around points or lines to
produce spherical or cylindrical multipstch features,

A8

summarize] X

Summarize Nearby 5

Finds features that are within a specified distance of
features in the input layer and calculates statistics for the..

F %

iii. Distance measurement: walking time

iv. 10
v. Distance units: minutes
vi. Run

Edit layer name and symbology as needed

©University of Auckland - Do not disseminate without prior written confirmation

Summarize Within (42
Overlays a polygon layer with another layer to summarize
the number of points, length of the lines, or area of the p...

g

16

Lab

Geoprocessing v R X
® Buffer ®

@  The Painuise Buffertool provides enhanced ~
functionality or performance.
No pending edits.
X
9
@

Parameters Environments

Input Features
centerpoint -] ..

© The input has 2 selection. Records to be processed: 1 &

Output Feature Class
[ centerpoint_Buffer |

Distance [value or field] [Lincar Unit -]
| I 500 [Meters -

Method

[ Plenar -]

Dissolve Type

No Dissolve -|
Geoprocessing v B X

Summarize Nearby

@  This tool consumes ArcGIS credits.

X
@

Parameters Environments

Input Features
centerpeint

© The input has a selection. Records to be processed: 1 3

Input Summary Features

[ centerpoint

oo i ciienbacaeiak )

Output Feature Class

centerpoint_SummarizeNearby

DTetance eacurerment

Walking time -

Distances
10|

(F) Add anather

[ Minutes

I Distance Units

Time Zone
[ Geolocal -]

[ Keep polygons with ne points

Summary Fields
Field Statistic

(] Add shape summary attributes

Group Field
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share Feature Lajer
o = Add Graphics Layer

Displaying data within site

*  Map > Select by location

* Input features: Bus stop

* Relationship: intersect = / e \
» Selecting features: 10 minute walkable |
catchment /
* Apply and Ok ’ . |:|
* Right click the bus stop layer and selection > '
create layer from selection
* Rename layer and change symbology as Your map should now look something like this:
needed

*  Map > Clear to clear your selection to finish

17 ORH
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Adding a new Layout

e S - MyNewProject | P

Project  Map Analysis  View  Edit  Imagery  Share Featurelayer  labelng  Data

5 New Report ] Import Map B + Ie . . I' ; . : .
New B L et Bright DarkMap  Light Map Paired Pastel Map  Red Gre
Map g8 Toolbox v 5] Task ons der | | MapNotes  Motes Notes  MapNotes  Notes  Mapho
Al
Cont 150 - Portrait
T ‘ s .
1. Insert > New Layout > A3 Iso , 0 -
— ] ]
. AS Ad A3 A2 Al A0
2. Insert > circle > Map frame 0 OO OO SR
AF = =
150 Landscape
M-, 3
[l =
L] . N Oy Y
7 L
& As a4 a3 Az A1 A0 ¥
148 mm x 210 mm 210 mm x 297 mm 297 mm % 420 mm 420 mm x 584 mm 594 mm x 841 mm 841 mmx 1189 mm )
EEgo-o- s Tutorial | £ Co : = =
Project  layout  Insert  Analysis  View  Imagery  Share

ﬂ Q {51 New Report (] Import Map +:j f=r

it New Notebook ~ £ Import Layout v

Refresh Map Series III 051w g* AN

New Connections Add Map North Scale Legend Chart ’
Map+ Layout g5 Toolbox « i A Series+ S B & R e 4 Y
I
Project Allv Map surrounc
Al ) >
Contents vnx [ElMep m Map .-
-} S=
T e ]| P
. ]
t= £ B E
Drawing Order B ;
2 bgrn ] Default Extent T6.227
] Other
4 <None>
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Adding Map Components

 Under the Insert tab, you can . - ) =L
add a North Arrow, Scale Bar, 5 o E S &
and Legend. = | - =
* Add a Map Title by inserting ) =
straight text. it !
* Add a Scale by inserting Dynamic :
Text. -
* Double click the elements (the E
components you’ve added) on e %
the map to edit their properties 7 &
in the Element tab. . ’ A J =
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Saving and Exportin

* Onceyour mapisreadyto oo o

export as a different file
type (e.g. PDF), go to the =
Sharetab. =
» Select Export Layout.
* Click Export at the bottom

right. B
e All done! o

Dats
Stor

Analysis

v =
roject L Print
Template - Fi Layou
Map B
- 1
/
] [
|
\
] \
\
\
\
b
1:6,000

_ Auckland Domain

500m pedshed
10 minute walkable catchment

| 01008 0 o1 a2 03 o4
| L e e L
| Scale: 1:6,000

sments\ArcGIS Projects\ Tutoria!
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Final Product

77 10 minute walkable catchment
I ACG Parnell
" University of Auckland

* BusStop

0.1 005 0 01 02 03 04
Emm-s
Scale: 1:6,000
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Helpdesk
Architecture Building Level 4, Room 423 (421-423).
drh022@aucklanduni.ac.nz

Opening Hours:
Mon-Fri: 9:30am-4:30pm
We do not open during public holiday

Appointments only during school breaks

drh.nz

For more about ™ Jf=J=d 3

O. drh.nz

=
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